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PSoC® Creator™ 4.1 Update 1 Release Notes

Overview

PSoC Creator 4.1 Update 1 is a minor update to PSoC Creator 4.1. This release contains several defect
fixes that improve the overall user experience. It includes all functionality from the original PSoC Creator
4.1 release. If you already have PSoC Creator 4.1 installed, then your existing version will be updated. If
you do not already have version 4.1, then the complete PSoC Creator 4.1, Update 1 release will be
installed.

The original PSoC Creator 4.1 release added web-based content delivery, enabling rapid installation of
new device support, new and updated component versions, and Code Examples. This release also
added support for pre- and post-build user commands and improved the user experience for several
existing features, with a refresh of the popular Start Page and changes to the parameter editor dialog.

This release does not replace existing production versions of PSoC Creator (e.g., 3.2, 3.3, or 4.0); it
installs alongside them. We guarantee that your existing designs can be opened in the new software, but
please upgrade your components to the latest version. To ensure that you can always return to your
previous setup, a backup of your project is automatically created when opening a project in a new version
of the tool. It is stored in a folder named "backup" in the project’s folder.

If you have technical questions, visit www.cypress.com/go/support.
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Update 1 Features

This update includes the following defect fixes:

ID Description

281150 Unable to place a breakpoint after upgrading project from PSoC Creator 4.0.

281278 Custom compiler flags are ignored and generate a warning.

282311 PSoC Creator 4.1 router erroneously assumes that a TCPWM signal can be routed through the

programmable analog subsystem and generates routing error messages (e.g. E1216: Routing of net
<net> Failed).

282578 Components in user libraries that target a generic device are reported as incompatible (regardless of
the target device).

282537 Error from .NET on opening PSoC Creator (Unable to open file from disk: (A window with the key
<key> is already being managed by the dock manager).

277352 Debugger fails to update Watch, Local and Memory windows for PSoC 5LP devices with less than
64 kB SRAM.

282602 PSoC Creator 4.1 erroneously prevents valid pin selections for CSD Comparator.

276933 Tool disallows XTAL watchdog setting below 5, preventing the use of a series resistor with a low
power oscillator.

276092 Bootloadable projects fail to build after exporting to IAR Embedded Workbench due to errors in the
makefile and postbuild.bat.

278305 Projects containing a USBFS Component but targeting a device that does not support USB generate
a System.IndexOutOfRangeException exception when building.

281114 New project wizard erroneously complains that "No code example has been selected." and gives no
indication how to download it.

278407 PSoC Creator 4.1 router times out in the pin selection phase causing the build to fail unless some of
the design’s pins are manually locked in the Pins Design-Wide Resource editor.

278409 Can't download incompatible Component via Web-based Content Delivery (WCD).

278778 Old Cypress logo is shown in Default schematic template.

275333 PSoC Creator installer executable includes old logo icon.
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Known Issues

This section lists the known issues with this release:

ID Problem Workaround
274102 | There are large performance problems in the Unplug the device you do not currently intend to
Select Debug Target GUI while one device is debug.

connected to CMSIS-DAP and another device is
connected to a MiniProg3.

PSoC Creator 4.1 Features

This release included the following PSoC Creator features:
Web-Based Content Delivery

Pre- and Post-Build User Commands

Improved Single-Step Debugging

Start Page Updates

Component Customizer Dialog Updates

Web-Based Content Delivery

With this release, you can now obtain updates to devices (including modules), Components, and code
examples from the Cypress web page. This will reduce the overall size of PSoC Creator in the future,
providing faster installs and updates. The other key benefit of web-based content delivery is that new
content can be distributed as soon as it is ready, instead of waiting for the next PSoC Creator update.

The Tools menu has been updated to add two items to find new Components and devices.

Taals | Window  Help

A% Find new components

Find new dewvices

Install drivers for phfision
Datapath Config Toaol...
Dkd&, Wfizard...

Cormponent Tuners L

L] Bootloader Host..,

Dptions..,

As part of this feature, many older versions of Components have been removed from this release. See
the Removing Older Component Versions section.
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The Find Code Examples dialog has been updated with indicators when new/updated code examples are
available.

Find Code Example =HEl X
Device family: [All - fon | Sample Code & ap
P
Filter by: ¥ | There is currently no project selected

When an example project is selected
from the list, this tab will display
information about that project.

ADC_Differential_Preamplifier
ADC_Differential_Preamplifier01
ADC_DifferentizlMode

@ ADC_DMA_VDAC

ADC_Mullnp

ADC_SAR_PrISM
ADC_SAR_Seq_DieTemp_PSoC4
ADC_SAR_Seq_Example
ADC_SingleEndedMode
ADC_Voltagelnp

[m] »

BasicDesign
BLE_4.2_Datalength_Security_Privacy
BLE_AlertNotification
BLE_Apple_Notification_Client
BLE_Battery_Level

Pre- and Post-Build User Commands

The Build Settings dialog was also updated to provide a User Commands page. This feature allows you
to run custom, user-specified, commands before or after the compile steps.

Build Settings B )
Configurstior: [ Debug (éclive] -
Toolchai [8RM GCC 5.4-2016-q2update -
- Designiil 4 User Commands
- Code Generation Pre Build
#-Debug Post Buid

#-Customizer

Petipheral Driver Library

+TargetIDEs

[=-ARM GCC 5.4-2016-q2-upc
General
Assembler

Cormpiler

.

kel

Pre Build
Specifies a custom command to execute befare compiling.

oK l l Apply ] [ Cancel

Improved Single-Step Debugging

Single-Step debugging PSoC 4 and PSoC 5LP designs with interrupts now works much more smoothly.
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Start Page Update

The Start Page has been updated to remove a lot of clutter and to focus only on the key areas that most
users want to see. There are now three sections: Learn, Start, and Recent.

L PSoC Creator 4.1 E=n B =<
File Edit View Project Build Debug Tools Window Help
BDSEHd S 3] %@ X R
£ Start Page | - Ak x |k
g|lteer What's new in PSoC Creator 4.1 = 1
g Getting Acguainted . 5
2 Newinar g
3 Newss and Infarmation The latest release of PSoC Creator combines great new features and support for exciting new PSoC devices. =&
Start New Devices
Create New Praject.. ) ) . . :
Open Existing Project... We are adding support for two new series of PSoC 4 devices and extending System Hardware Manager to include SHM35x3L
Find Code Exarnple .. devices.
Hits & PSoC 4000DS and PSoC 4200DS are a pair of entry level ARM Cortex-M0O MCU series with highly programmable and
Recent configurable digital functions in the smallest form factor. Unlike 4000DS, the 4200DS parts include universal digital blocks
Warkspace348.cprk (UDB).
Workspace3dZ.cywrk The SHM35x3L System Hardware Manager extends Cypress's family of turnkey and programmable solutions targeted

towards Power Supervision, Thermal Management and control applications

Web-Based Content Delivery

The big change in this release is the ability to get updates to Cypress content from our web site. The key benefit of web-based
content delivery is that devices, Components, and code examples can be distributed as soon as they are ready, instead of
waiting for the next PSoC Creator update.

The Tools menu has been updated to add two items to find new Components and devices. Simply click on the menu items to
check for, and download, new content whenever you choose.

Taols | Windaw  Heln

| Output | Mokice List

Ready OErrors DWarnings 0 Notes

The Learn section provides links to three types of information. “News and Information” is a blog with
design features, event news, kit releases, and other interesting PSoC stories. “New in 4.1” provides
experienced users with an overview of the new features in the release. “Getting Acquainted” gives a very
general introduction to key aspects of the product for new users.

The Start section is where you’ll create new projects, either from scratch or from code examples.

The Recent section lists the most recent workspaces and projects you've worked on so you can jump
back into them quickly.
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Component Customizer Dialog Updates

PSoC® Creator™ 4.1 Update 1 Release Notes
SRN12794

Cypress has made several small enhancements to the default Configure dialog to improve the user
experience with Components. There are now more ways to describe the parameters, make calculations

with them, and guide the user to legal choices.

~/"Basic | Pins | Buit-n qp
= Clock Source
Enable Clock Fram Terminal &
= General
Mode Shave [= a9
Data Rate (kbps) 1nn fix)
Hse TXFIFO o 59 | actral dota rate (kbps): 100
Use RX FIFO = ft= | |5cB clock (kHz): 15625
= Slave tLona (sl 5120
Slave Address (T-bit) 108 fg | IO ek 5120
Slave Address Mask (8-bit) 0<FE fix)
Accept Matching Address in RX FIFO =) fis)
Accept General Call Address = fi=)
Enable Wakeup Fram Deep Sleep Made  |[7] fix)

Components/Code Examples

This release includes the following new and updated Components, as well as code examples for them.
Refer to the Component datasheets and code example documents for more details.

New Components
m ADC _UAB1.0

Updated Components

ADC_SAR_SEQ P4 2.50
CapSense_P4 4.0
CSD_ADC 1.10

cy_boot 5.60

cy_Ifclk 1.20

LIN 4.0
PowerMonitor_P4 2.0
Scan_ADC 1.30

Smart /O™ 1.10
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Design Impact

PSoC Creator 4.1 will not Find Some Older Component Versions

As mentioned under the Web-Based Content Delivery section, only the latest versions of Components
now ship with the product. If you are working on a project and update your software to PSoC Creator 4.1,
you will see the following symbol in the schematic file for impacted components.

CapSense_1
Cannot find v 3.10 of component
CapSense_P4
This design uses an older version of a component
than is available in your dependencies. Please
update the component via the Project > Update
Components menu.

To resolve this issue, you have the choice between the following:
m  Download the original versions using Web-Based Content Delivery tools.
m  Update to the latest versions, which are always included in the distribution.

Component Versions Available from the Web

The following older Component versions from PSoC Creator 4.0 and previous releases have been
removed from this release. They remain supported and available for download via Web-Based Content
Delivery. Also shown are the latest Component versions available in PSoC Creator 4.1.

Component PSoC PSoC Component PSoC PSoC
Creator 4.0 |Creator 4.1 Creator 4.0 |Creator 4.1

ADC_DelSig 3.0 3.20 BLE 3.20 3.30
ADC_DelSig 3.10 3.20 Bootloadable 1.20 1.50
ADC_SAR 2.10 3.0 Bootloadable 1.30 1.50
ADC_SAR_SEQ 1.10 2.0 Bootloadable 1.40 1.50
ADC_SAR_SEQ P4 2.0 2.50 Bootloader 1.20 1.50
ADC_SAR_SEQ P4 2.10 2.50 Bootloader 1.30 1.50
ADC_SAR_SEQ P4 2.20 2.50 Bootloader 1.40 1.50
ADC_SAR_SEQ_P4 2.30 2.50 CapSense_CSD 3.40 3.50
AMuxSeq 1.70 1.80 CapSense_CSD_P4 2.20 2.60
BLE 2.0 3.30 CapSense_CSD_P4 2.30 2.60
BLE 2.10 3.30 CapSense_CSD_P4 2.40 2.60
BLE 2.20 3.30 CapSense_CSD_P4 2.50 2.60
BLE 2.30 3.30 CapSense_P4 3.0 4.0
BLE 3.0 3.30 CapSense_TMG 1.0 1.20
BLE 3.10 3.30 CharLCD 2.0 2.20
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Component PSoC PSoC Component PSoC PSoC

Creator 4.0 |Creator 4.1 Creator 4.0 |Creator 4.1
CharLCD 2.10 2.20 SCB_P4 2.0 3.20
Comp_P4 1.0 1.20 SCB_P4 3.0 3.20
cy_pins 25 2.20 SCB_P4 3.10 3.20
CyControlReg 1.70 1.80 SegLCD_P4 1.10 1.30
cydff 1.0 1.30 SegLCD_P4 1.20 1.30
cydff 1.10 1.30 SMBusSlave 2.20 5.20
cydff 1.20 1.30 SMBusSlave 3.0 5.20
DFB 1.30 1.40 SMBusSlave 4.0 5.20
DVDAC 2.0 2.10 SMBusSlave 5.0 5.20
EZI2C 1.90 2.0 SMBusSlave 5.10 5.20
Fan Controller 3.10 4.0 SPI_Slave 2.60 2.70
12C 3.30 3.50 SW_Tx_UART 1.10 1.50
12C 3.40 3.50 SW_Tx_UART 1.20 1.50
12C_LCD 1.10 1.20 SW_Tx_UART 1.30 1.50
12S 2.50 2.70 SW_Tx_UART 1.40 1.50
12S 2.60 2.70 TCPWM_P4 1.0 2.10
ILO_Trim 1.10 2.0 TCPWM_P4 1.10 2.10
LIN 1.30 4.0 Timer 2.60 2.70
LPComp_P4 2.0 2.20 Trim and Margin 1.30 3.0
LPComp_P4 2.10 2.0 Trim and Margin 2.0 3.0
MDIO_Interface 1.0 1.20 UART 2.30 2.50
MDIO_Interface 1.10 1.20 UART 2.40 2.50
OpAmp_P4 1.10 1.20 USBFS 2.60 3.10
PWM 3.0 3.30 USBFS 2.70 3.10
PWM 3.10 3.30 USBFS 2.80 3.10
PWM 3.20 3.30 USBFS 3.0 3.10
QuadDec 2.40 3.0 Voltage Fault Detector 2.30 3.0
Resistive Touch 1.30 2.0 Voltage Sequencer 3.21 3.40
RTC_P4 1.0 1.10 Voltage Sequencer 3.30 3.40
ScanComp 1.0 1.10 WaveDACS 2.0 2.10
SCB_P4 1.20 3.20
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Obsolete Component Versions NOT Available from the Web

The following Components have been removed from this release and are not available through Web-
Based Content Delivery. They are obsolete:

m  FanController 3.0
m Scan_ADC 1.10
m UAB VDAC 1.0
m UABPRIM 1.0

Supported Devices

The design flow and tools available in this release of PSoC Creator support the following:

Family/Series Part Numbers

PSoC 5LP CY8C52*LP CY8C54*LP  CY8C56*LP CY8C58*LP

PRoC BLE CYBL1*

EZ-BLE modules CYBLE*

PSoC 4200, PSoC 4200L, PSoC 4200M, cysc42* CY8C42+L CY8C42*M CY8C42*BL

PSoC 4200 BLE, PSoC 4200DS CY8C42*DS

PSoC 4100, PSoC 4100M, PSoC 4100S, CY8cC41* CY8C41*M CY8C41*S CY8C41*BL

PSoC 4100 BLE

PSoC 4000, PSoC 4000S, PSoC 4000DS CY8C40* CY8C40*S CY8C40*DS

PSoC Analog Coprocessor CY8C4A*

PSoC 3 CY8C32* CY8C34* CY8C36* CY8C38*

System Hardware Manager (SHM) CYSHM*

FMO+ S6E1A* S6E1B3* S6E1B8* S6E1C1*
S6E1C3*

Supported Tool Chains

Toolchains for ARM-Based Devices

ARM GCC - The GCC ARM Embedded toolchain GCC 5.4-2016-g2-update is installed with PSoC
Creator. This toolchain has no use restrictions and does not require license activation (it is distributed
under the terms of the GNU Public License).

ARM GCC Generic — This option can be used to select a separately-installed version of the ARM GCC
toolchain.

ARM MDK Generic — This option can be used to select a separately-installed version of the ARM
Microcontroller Development Kit. The officially supported version is 4.72a.
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Toolchains for PSoC 3 (8051)

DP8051 Keil™ 9.51 — The Keil PK51 Professional Developers Kit for PSoC is installed with PSoC
Creator. It supports optimization levels 0 through 5. If you would like to use the compiler optimization
levels above level 5, you should purchase the standard PK51 product by contacting Keil.

m In North, Central, or South America... sales.us@keil.com

m In Europe, Asia, Africa, or Australia... sales.intl@keil.com

The free Keil toolchain comes with a 30-day evaluation license. You can extend the license, without cost,
by registering the product from within PSoC Creator (Help > Register > Keil...). Note that the extended
license is for one year and that you will need to re-register it each year.

DP8051 Keil Generic — This option can be used to select a separately-installed version of the Keil
toolchain. While any version can be selected, the only officially supported versions are 8.16, 9.03, 9.51.

Installation

Minimum and Recommended System Requirements

The following are system requirements to install and use PSoC Creator. Each requirement specifies a
minimum that your system must meet or exceed.

PSoC Creator will execute correctly in highly resource-constrained systems. However, performance
(startup time, project creation and opening, build times, and so on) may be impacted when resources are
scarce. The most directly impacted performance metric is build time. The following sections provide
examples of the resource scarcity impact.

Note During initial startup, PSoC Creator builds and caches component DLL files used to display the
component parameter editors. As a result, the tool will launch less quickly the first time after a new
installation or a Windows® reboot.

Summary

Hardware/Operating System Requirements Minimum

=  Processor 1.3 GHz or faster 32-bit (x86) or Intel 64/
AMDG64 64-bit

= RAM 1.5GB
=  Free Hard Drive Space 5GB
= Screen Resolution 1024x768
= USB 2.0

Software Prerequisites * Minimum Version
=  Microsoft Internet Explorer (not IE8 beta) 7
= NET Framework 4.0
= Adobe Reader (for viewing PDF Documentation) 9.2 **
=  Windows Installer 3.1
=  PSoC Programmer 3.26 (included with PSoC Creator)
= Keil Compiler (For PSoC 3 Only) 8.16 (9.51 provided)
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* Toinstall and run PSoC Creator, you may also need to install additional software. The Cypress Installer
will guide you through the process if the additional programs are not already installed.

** For Windows 7, the minimum required version of Adobe Reader is version 9.2. You can download the
latest version here: http://get.adobe.com/reader/. You can also use a non-Adobe PDF reader if you
prefer; however, Cypress has no recommendations for any particular non-Adobe reader or version.

Processor
1.3 GHz or faster 32-hit (x86) or Intel 64/AMD64 64-bit processor is required.

PSoC Creator exhibits a predictable relationship between CPU speed and build time above 1.3 GHz.
Doubling the CPU speed, e.g., from 1.5 GHz to 3 GHz, almost halves the build time.

On a fast (3 GHz) PC, simple designs can build in about one minute. At low speeds even designs that fill
the device and generate complex routing solutions will build in under 5 minutes.

Operating System

One of the following Windows platforms is required:

Windows 7 and Windows 7 SP1 (32- and 64-bit supported)
Windows 8 and Windows 8.1 (32- and 64-bit supported)

Windows 10 (32- and 64-bit supported)

Mac OS X El Capitan on VMware Fusion 8 running Windows 8.1
Mac OS X El Capitan on Parallels Desktop 11 running Windows 10
Ubuntu 15 Linux with Oracle VM VirtualBox running Windows 10

Memory

A minimum of 1.5 GB of RAM is required.

Free Disk Space

PSoC Creator requires 5 GB of free disk space. PSoC Creator will install and run with just 1 GB of free
disk space. However, in order to allow Windows to do memory paging, we recommend a minimum free
disk space requirement of 5 GB.

If your disk is highly fragmented it will severely impact memory paging time and can result in very long
build times. Disks that are nearly full are particularly prone to fragmentation. We recommend de-
fragmenting your disk if you experience excessively long build times (10 minutes or more).

USB

PSoC Creator requires a USB 2.0-compliant host to program and debug.

Screen
A resolution of 1024x768 pixels or higher is required.

Note The build time examples given above were obtained with new product installations on minimally
fragmented disks with no other applications running. If your build times exceed these expectations we
recommend closing unnecessary applications, adding RAM to the system (to reduce paging) and
ensuring that there is sufficient free and unfragmented disk space.
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Software Update Instructions

As part of the installation process, the Cypress Update Manager utility will also be installed and located
on the Start menu. You can use this utility to update all Cypress programs you have installed when
updates for them become available.

Open Source

Portions of this software package are licensed under free and/or open source licenses such as the GNU
General Public License. Such free and/or open source software is subject to the applicable license
agreement and not the Cypress license agreement covering this software package. The applicable
license terms will accompany each source code package. You may obtain the source code of such free
and/or open source software at no charge from the following web site: www.cypress.com/go/opensource.

Installation Notes

The installation process is a set of wizards that walk you through installing various components. You can
install PSoC Creator and various prerequisites from the web or from a DVD. There are slight differences
in the process based on the medium used to install the software.

The DVDs provide the necessary prerequisites and the wizards to guide you through installing the
appropriate software. The following sections contain more specific installation details.

Note Do NOT plug in your Miniprog3 until all software installation is complete AND the PSoC Creator
application has been opened.

PSoC Creator DVD Installation

The PSoC Creator DVD contains PSoC Creator and PSoC Programmer, as well as various prerequisites.

1. Load the DVD. The main installer program should run automatically. If not, double-click the
cyautorun.exe file to launch it.

2. On the main installer, click the Install PSoC Creator <version> button to launch the PSoC
Creator InstallShield Wizard.

3. Follow the prompts on the wizard. The Cylnstaller for PSoC Creator opens and displays steps to
install PSoC Creator.

4. Click the hyperlink for any software that is not installed as indicated (such as, Acrobat Reader,
etc.). Run the installer for that program as needed.

5. Continue following the prompts to install PSoC Creator.

Cypress PSoC Kit DVD Installation

A kit DVD contains PSoC Creator and PSoC Programmer, as well as projects, documentation, and
prerequisites needed for the associated kit. Refer to kit instructions.
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Web Installation

If you are downloading the software from the web (www.cypress.com/creator), run the PSoC Creator
single package executable.

1. Double-click the PSoC Creator executable file to launch the installer.

2. Follow the prompts to install PSoC Creator. The Cylnstaller for PSoC Creator opens and displays
a series of steps to install PSoC Creator, and it will perform pre-requisite checks and install the
prerequisites.

3. When complete, close the installer.

Further Reading

The primary documentation for PSoC Creator is provided in the Help, which you can open from the Help
menu or by pressing [F1]. Other documents included with this release are also available from the Help
menu, under Documentation. These documents include (but are not limited to):

m  Quick Start Guide
m  System Reference Guide
m  Component Author Guide

Cypress provides a web page specifically for PSoC Creator at www.cypress.com/creator.

Other documentation includes (but is not limited to):
m Device Datasheets
Device Architecture Technical Reference Manual (TRM)
Device Registers TRM
Application Notes
Training

Contact your Cypress representative, as needed.
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